2015

TAMC PASER

Training Manual

Manual Prepared by:
The Center for Technology & Training (CTT)
Michigan Technological University

Revised: February 2015
Table of Contents

Introduction.......................................................................................................................................................... 1

Section 1: Data Collection Requirements ........................................................................................................ 2
  PASER data collection regulations .................................................................................................................. 2
    Roads that must be rated ............................................................................................................................ 2
    Definition of “Federal-aid eligible” .............................................................................................................. 2
  Collection timeline ......................................................................................................................................... 3
  Rating teams ................................................................................................................................................... 3
  Required training sessions ............................................................................................................................ 3
  Reimbursement .............................................................................................................................................. 3
  Quality control .............................................................................................................................................. 3

Rating roads effectively .................................................................................................................................... 4
  Rating speed .................................................................................................................................................. 4
  Rate distress, not ride quality ....................................................................................................................... 4
  Measuring rutting .......................................................................................................................................... 4
  Group dynamics .......................................................................................................................................... 4
  Lighting conditions ...................................................................................................................................... 4
  Inclement weather ...................................................................................................................................... 4
  Boundary segments .................................................................................................................................... 5
  Basic pavement information ....................................................................................................................... 5
  PASER descriptors vs. TAMC definitions ....................................................................................................... 5
  Selecting the lane to rate .............................................................................................................................. 6
  Road use or importance does not influence rating ....................................................................................... 6
  Dealing with road construction projects ...................................................................................................... 7
  Rate what you see ....................................................................................................................................... 7
  Light-colored pavement ............................................................................................................................... 7
  Paved shoulders ........................................................................................................................................... 7

Data management ............................................................................................................................................ 7
  Working with smaller cities and villages ...................................................................................................... 7
  Splitting segments ....................................................................................................................................... 8
  Errors in the framework map ....................................................................................................................... 8

Safety concerns ................................................................................................................................................ 8
  General safety ................................................................................................................................................ 8
  Seating within the vehicle ............................................................................................................................ 8
  Replacement vehicles ................................................................................................................................ 8
  Computer hardware ..................................................................................................................................... 9

Section 2: Data Collection Procedure ........................................................................................................... 10
  Step 1: Identify your TAMC network for data collection ........................................................................... 11
  Step 2: Export TAMC network for use with the LDC ................................................................................. 12
Step 3: Send a copy of TMC network to the CSS ................................................................. 13
Step 4: Import the network into the Laptop Data Collector (LDC) .............................................. 14
Step 5: Connect the GPS to your laptop and begin collecting data ............................................... 15
  Connect the GPS .................................................................................................................... 15
  Collect data ......................................................................................................................... 15
Scenario A: Agencies that must define their Federal-Aid Unpaved Road Network inventory .......... 17
  Scenario B: Agencies that have already defined their Federal-Aid Unpaved Road Network inventory 17
Step 6: Export collected data from the LDC ............................................................................... 19
Step 7: Import the collected data to Roadsoft ............................................................................. 20
Step 8: Export Roadsoft asset management data for the regional version of Roadsoft ................. 21
Step 9: Import Roadsoft asset management data from the local agency into the regional version of Roadsoft .............................................................................................................. 22
Step 10: Export shape file and submit to TMC ............................................................................ 23
Section 3: Michigan-specific Information ...................................................................................... 24
  Sealcoat Road Rating Guide .................................................................................................. 24
  Using the “Percentage” approach .......................................................................................... 24
  Michigan Sealcoat Rating Guide Table .................................................................................. 25
  Rutting and Asphalt PASER Manual ..................................................................................... 26
  Block Cracking and Asphalt PASER Manual ........................................................................ 26
  PASER 9 and Concrete PASER Manual ................................................................................ 26
Section 4: Splitting Segments ........................................................................................................ 27
  Guiding principles for splitting segments ............................................................................... 27
  Good reasons for splitting segments ....................................................................................... 27
    Change in Surface Type ....................................................................................................... 27
    Number of Lanes ................................................................................................................ 27
    Intersection as a Unique Facility ........................................................................................ 27
    Environmental Factors ....................................................................................................... 27
  Bad reasons for splitting segments ....................................................................................... 28
Section 5: PASER Data Quality Control Guide ............................................................................ 29
  Step 1: Determine the total length of your network ................................................................. 29
  Step 2: Determine the total length of paved segments in your network .................................. 29
  Step 3: Verify that your agency’s TMC data are accurate ....................................................... 30
  Table of quality control queries ........................................................................................... 30
Appendix A – Michigan’s Regional Planning Organizations ......................................................... 31
Appendix B – Michigan’s Metropolitan Planning Organizations ................................................ 32
Appendix C – New Midland Area Transportation Study (MATS) Boundary .............................. 33
Appendix D – PASER Certification/Training Requirement Policy .............................................. 34
Appendix E – Data Collection Timesheet .................................................................................... 37
Appendix F – Framework Error Form ........................................................................................ 38
Introduction

The Pavement Surface Evaluation and Rating (PASER) system is a visual survey method for evaluating the condition of roads. The method was developed by the University of Wisconsin Transportation Information Center to provide a simple, efficient, and consistent method for evaluating road condition. Michigan’s Transportation Asset Management Council (TAMC) has adopted the PASER system for measuring statewide pavement conditions in Michigan.

Part of TAMC’s mission is to obtain accurate PASER that provides a clear view of the condition of the road network in Michigan. TAMC uses these ratings to communicate the condition of Michigan roads to the Michigan Legislature. At the local level, this data serves as the foundation on which to build cost-effective pavement maintenance strategies.

TAMC chose Roadsoft—a roadway management system for collecting, storing and analyzing data—for use in developing its statewide pavement rating collection strategy. Roadsoft is funded through the Michigan Department of Transportation (MDOT) and developed, supported, and distributed by Michigan Technological University’s Center for Technology & Training (CTT).

TAMC also works in conjunction with Michigan’s Regional/Metropolitan Planning Organizations (RPO/MPO) to collect PASER data. Although these regional organizations operate under many different names and serve a variety of different areas, they all participate in coordinating and performing PASER data collection.

This manual describes the requirements and processes involved in collecting PASER data for TAMC in conjunction with the RPO/MPOs. It also includes information on how to split segments, rate sealcoats, and double-check collected PASER in Roadsoft.
Section 1: Data Collection Requirements

PASER data collection regulations

According to Act 51 (P.A. 499 2002, P.A. 199 2007) each local road agency shall annually report the mileage and condition of the road and bridge system under their jurisdiction to TAMC. To fulfill the requirement of this Act each year TAMC sets requirements for road condition data collection and submission by road-owning agencies in Michigan.

Road condition rating is eligible for reimbursement from TAMC if the required training is attended and proper documentation is submitted at the end of the collection process.

Roads that must be rated

At least 50% of Federal-aid eligible, paved roads must be rated. There are three categories of data required for each rated road with a paved surface:

1. Surface Type
2. PASER
3. Number of Lanes

Unpaved road inventory (surface type only) should be collected for unpaved roads in the Federal-aid eligible system. Unpaved inventory collection on the non-federal aid system will not be reimbursed. Collection teams will collect all information on unpaved road types (unimproved earth and gravel to be classified at the local agency’s discretion) within their (50% of the Federal-aid eligible) network for collection each year. Based on current estimates, unpaved roads should be approximately 4% of the Federal-aid system.

Definition of “Federal-aid eligible”

According to 23 USC § 101, “Federal-aid eligible” roads are “highways on the Federal-aid highway systems and all other public roads not classified as local roads or rural minor collectors.” This definition can be stated in terms of NFC class, where the NFC is 1, 2, 3, 4, 5, or 6 where one or both sides of the road on or in an urban boundary (RU_L > 1 or RU_R > 1). NFC codes are defined as:

- 1 – Interstates
- 2 – Other Freeways
- 3 – Other Principal Arterials
- 4 – Minor Arterials
- 5 – Major Collectors
- 6 – Minor Collectors
- 7 – Local
- 0 or uncoded – not a certified public road

RU_L | 1 Rural/Urban designation left
RU_R | 1 Rural/Urban designation right

- 1 – Rural area
- 2 – Small urban area (5,000 to 49,999)
- 3 – Small urbanized area (50,000 to 199,999)
- 4 – Large urbanized area (200,000 or more)
For paved Federal-aid data collection the council collects PASER data based on the above definition of “Federal-aid eligible”, so you will not be collecting PASER data on Rural Minor Collectors. Using the Roadsoft query of “Federal Aid = True” will take this change into account and give you the correct network conforming to the current definition.

Collection timeline

- Data collection begins: April 1, 2015
- Data collection completed by: November 27, 2015
- Data submitted to the Center for Shared Solutions (CSS) by: December 4, 2015

Rating teams

Teams should be comprised of one member from MDOT, one member from the Act-51 jurisdiction’s RPO/MPO and one member from the jurisdiction being rated (County, City, or Village).

To schedule your PASER data collection, contact your RPO or MPO. See the maps in Appendix A, Appendix B, and Appendix C to determine your jurisdiction’s planning office. See http://miregions.com/michigan-planning-regions/ if you need contact information for an RPO or http://www.mtpa-mi.org/members.asp if you need contact information for an MPO.

Required training sessions

Anyone who participates in the annual PASER data collection of the federal-aid system and influences the rating activity must attend on-site PASER training in the same year the data collection occurs. In addition to attending one on-site session, raters who did not attend PASER training the year prior must attend one supplemental PASER webinar session.

TAMC has instituted a testing and certification program for PASER data collectors who attended PASER training and collected PASER data for multiple years. The certification allows experienced raters to opt out of training in future years. The full certification/training requirement policy and a link to TAMC policy is attached as Appendix D of this document.

Reimbursement

Data collection for federal aid is reimbursable for qualified individuals. Non-Federal-aid collection reimbursement can be given if previously approved by TAMC coordinator. Requests for prior approval to collect non-Federal-aid data for reimbursement and invoices for rating efforts (see Appendix E) should be submitted through your RPO/ MPO to:

Frank Kelley
Michigan Department of Transportation
PO Box 30050
425 W. Ottawa St.
Lansing, MI 48909
kelleyf@michigan.gov

Quality control

The RPO or MPO coordinating PASER collection must review the collected data before sending it to the CSS. This quality control procedure is described in detail in Section 5.
Rating roads effectively

Rating speed

Rating roads at high speeds can cause inaccuracy. Reviews conducted by the CTT’s PASER trainers have shown that teams that view roadways at lower speeds are much more likely to rate them accurately. Rating roads at high speeds can cause distresses to be missed and ratings to be higher than appropriate.

Rate distress, not ride quality

Just because a road rides well doesn’t mean that it doesn’t have distress in need of capital preventative maintenance (CPM) or structural improvement (SI). This is especially true on a road with rutting and cracking in the wheel path, both of which can cause rapid deterioration. Conversely, an asphalt surface in relatively good condition, with sealed longitudinal cracks, often makes quite a bit of noise as tires pass over the expanded crack seal. More noise does not always mean severe distress. Don’t let ride quality distort your ratings.

Measuring rutting

It can be difficult to detect rutting when moving at high speeds on a sunny day. To help avoid incorrect rutting assessments, each regional office is provided with a six-foot aluminum T-bar. By using the bar in conjunction with a tape measure, teams can quickly get a tangible assessment of the extent of rutting on a road where it is practical and safe to do so. It’s the rating team’s decision to choose whether or not to physically measure rutting.

Group dynamics

Teams need to be aware of group dynamics in their vehicles. Condition rating is supposed to be a group process. However, the process also needs to conform to PASER procedure. Teams should read the PASER descriptions closely and refer to the reference sheets for clarification.

Lighting conditions

Changes in lighting conditions and the time of day can influence how some distresses are perceived. Bright sunlight directly overhead may make surface texture defects or fine cracking hard to discern. Rating early in the morning or late in the afternoon on a sunny day while driving into the sun may also make it difficult to rate roads effectively. If lighting conditions are poor, slow down or stop to make sure that you are not overlooking any visual cues.

Trees cause shadows that can appear to be road distresses. Tree shadows on the road make for very difficult rating conditions. Options are to return to the location at a different time or drive at lower speeds.

Inclement weather

PASER is a visual assessment system. Trying to rate pavement in the rain is ineffective. Road surfaces look different when they are wet—cracks look larger, puddles can hide distresses, etc. Teams should not rate roads when they are wet.
**Boundary segments**

Boundary roads (roads that fall between jurisdictions) often have non-standard characteristics and splits on the Roadsoft map. As a result, it may be unclear which jurisdiction is responsible for rating a boundary road.

To eliminate potential data collection issues when rating boundary roads, follow these two rules:

Rule 1: Follow the Data Collection Procedure (Section 2) carefully. The steps for collecting and submitting TAMC data are laid out in a specific order to prevent rated roads from being overwritten by unrated roads. If you deviate from the documented procedure, some of your rating data may be overwritten by unrated roads.

Rule 2: Rating teams should rate all boundary roads in their data collection networks, regardless of ownership or maintenance responsibilities.

**Basic pavement information**

The three main PASER manuals used by Michigan are for asphalt, concrete, and sealcoat. The PASER manual for brick is also used, as brick is reported but not widely taught. These can be found at [http://michiganltap.org/workshops/2014-paser-training](http://michiganltap.org/workshops/2014-paser-training)

Hot mix asphalt is a structural pavement type. Generally a structural hot mix asphalt layer has a thickness of 1.5” or more.

A composite pavement is an old concrete pavement that has an asphalt overlay. Composite pavements should be rated with the asphalt rating system, but be inventoried as a composite pavement.

A chip seal or a sealcoat on top of an asphalt pavement is not considered a sealcoat pavement because the asphalt below is considered the structural layer. This pavement should be rated with the asphalt rating system.

A sealcoat pavement is an unpaved road with a sealcoat (chip seal) surface treatment. There is no full-width structural layer of asphalt in a sealcoat pavement. This pavement should be rated with the modified Michigan sealcoat rating system, which uses a 1-10 scale.

The rating scale in the Brick & Block PASER manual is 1, 2, 3, 4. To be consistent with other pavement rating scales the brick and block scale must be doubled resulting in 2, 4, 6, 8 ratings while maintaining the original definitions from the manual. A rating of 10 would be reserved for brick and block pavements that are in a very good condition and less than one year old.

**PASER descriptors vs. TAMC definitions**

Each rating in the PASER Manuals includes written descriptors (Excellent, Very Good, Good, Failed, etc.) that are part of the rating category name and give an overall impression of the state of each rating. These descriptors are as follows for Asphalt and Concrete pavements:
<table>
<thead>
<tr>
<th>Rating</th>
<th>PASER</th>
<th>TAMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 &amp; 9</td>
<td>Excellent</td>
<td>Good</td>
</tr>
<tr>
<td>8</td>
<td>Very Good</td>
<td></td>
</tr>
<tr>
<td>7 &amp; 6</td>
<td>Good</td>
<td>Fair</td>
</tr>
<tr>
<td>5</td>
<td>Fair</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Fair</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Poor</td>
<td>Poor</td>
</tr>
<tr>
<td>2</td>
<td>Very Poor</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Failed</td>
<td></td>
</tr>
</tbody>
</table>

The PASER manual descriptors are not based on any formal definition relating to the quality of the pavement and they should not be confused with the formal definitions of “Good, Fair and Poor” that TAMC has developed and uses for reporting.

TAMC groups the 1-10 rating scale into three categories (Good 8-10, Fair 5-7, Poor 1-4) based upon a definition that relates to the type of work that is typically required for each rating grouping (Routine Maintenance, Capital Preventive Maintenance, Structural Improvement).

Routine Maintenance (RM) is the day-to-day, regularly-scheduled activities to prevent water from seeping into the surface. These activities include street sweeping, drainage clearing, gravel shoulder grading, and sealing cracks. PASER 8, 9, and 10 are included in this category. This category also includes roads that are newly constructed or recently seal coated. They require little or no maintenance. In TAMC nomenclature these roads are considered “Good.”

Capital Preventive Maintenance (CPM) is a planned set of cost effective treatments to an existing roadway that slows further deterioration and maintains or improves the functional condition of the system without significantly increasing the structural capacity. The purpose of CPM fixes is to protect the pavement structure; slow the rate of deterioration; and/or correct pavement surface deficiencies. PASER 5, 6, and 7 are included in this category. Roads in this category still show good structural support but the surface is starting to deteriorate. CPM is intended to address pavement problems before the structural integrity of the pavement has been severely impacted. These roads are considered “Fair.”

Structural Improvement (SI) is necessary for roads assigned a PASER of 1, 2, 3, or 4 which require some type of structural improvement such as resurfacing or major reconstruction. Alligator cracking is evident. Rutting is beginning to take place. Road rutting is evidence that the underlying structure is beginning to fail and it must be either rehabilitated with a fix like a crush and shape or it must be totally reconstructed. These roads are considered “Poor.”

**Selecting the lane to rate**

If there is a difference in quality, rate the worst lane.

**Road use or importance does not influence rating**

Don’t rate an important road less than the actual PASER. Don’t confuse a management decision with rating; Road ownership/use or importance does not change its distress rating.
Dealing with road construction projects
When rating a road currently under construction, if the old pavement is gone, the road should be rated as if the construction were complete. If the existing pavement is still there, rate what you see.

Rate what you see
Don’t anticipate the next PASER based on previous PASER data. Rate what you see. The value of the existing data is being a usable record of road improvements and ratings, costs, and extended life.

Light-colored pavement
Oxidized pavements can be very light and often look gray or off-white, which causes distresses to be less visible. Flat lighting on an oxidized pavement can also hinder visibility of distresses.

Paved shoulders
For paved shoulders, rate the pavement from edge line to edge line and omit the shoulder condition. Shoulders are not rated because they are constructed differently than the traveled way; there is not typically a structural layer in a shoulder so deterioration is different.

Data management
The data collection process needs to start with the local agency’s Roadsoft data set, not with an RPO or MPO’s version of Roadsoft. Collection teams should use local data – not regional data – as a starting point. For 2015 PASER collection you will need to update Roadsoft and the Laptop Data Collector (LDC) to versions 7.8 or newer (available by April 1).

Note that changes to data will only be sent to TAMC if they were collected in the LDC or hand entered in the region version of Roadsoft. Rating and changes in ratings should be initially entered in the LDC (not in Roadsoft) or data will not be reported.

Working with smaller cities and villages
Smaller cities and villages are often enthusiastic about the data collection process. However, it can be time-consuming to visit smaller communities (10 or 20 miles of Federal-aid eligible roads) in order to set up a Roadsoft network. If an agency has a limited number of miles in their jurisdiction there are a few options for including them in the data collection process.

In the latest versions of Roadsoft and the LDC, data collection exports from the LDC can be provided to small agencies as a means for transferring recently collected PASER data that were collected using an export from the county version of Roadsoft. This option should only be used for small cities and villages with their permission, because the historical road splits and historical data present in the small local agencies’ Roadsoft database will not be available to assist in collection activities. Medium to large cities and villages should collect data using an export from the agency’s version of Roadsoft as you would with a county.

Another option for dealing with very small agencies it to provide them with a report (PASER by Physical Reference segment) and have them manually enter data in their version of Roadsoft.
Both of these options allow data collectors to use the collection networks they build at their road commission without having to stop and upload data for these small agencies. Data collection should be dealt with on a case-by-case basis.

Splitting segments
If a team encounters an undocumented change in the surface type or layout of a road (such as number of lanes) they should create a split in the Roadsoft map to reflect the change. Detailed guidelines for creating splits can be found in Section 4.

Errors in the framework map
If a team suspects that they have discovered an error in their jurisdiction’s map, they should first place a short notation in the LDC memo field for that segment. Consistent use of a tag such as “error” can simplify creating a Roadsoft report containing these errors and the segments that they are located on. This information can be passed on to the CSS for correction.

Next, a team should fill out the Asset Management Change Request for Michigan Geographic Framework (Appendix F) and submit it to:

Joshua Ross  
Michigan Center for Shared Solutions  
Romney Building, 10th Floor  
111 S. Capital Ave  
Lansing, MI 48933

You can also request changes by contacting Mr. Ross at (517) 373-7910 or rossj@michigan.gov.

Safety concerns

General safety
During data collection, you will be merging in and out of traffic, slowing down, pulling off to the shoulder for team discussions, etc.—always take safety precautions. Driving the team vehicle is not something to be taken lightly. All the vehicles must be equipped with a warning light bar. Warning garments should be worn by raters that get out of the vehicle to better view distress or measure rutting. Above all, be sure to comply with your employer’s warning garment and safety procedure requirements.

Seating within the vehicle
The best configuration for a three-person team is the rater in the front passenger seat, and the data entry person in the back seat. If the data entry person sits in the front seat with a laptop, they could be injured by an airbag discharge, and can be distracting to the driver.

Replacement vehicles
If you need another vehicle, either use one from the county road commission or rent one. If you need to rent a vehicle, the MDOT rater should sign the rental agreement and purchase the extra insurance.
Computer hardware

Data collection teams are provided a laptop computer and a GPS unit by their RPO/MPO, but it is best to have a second laptop in the vehicle just in case something goes wrong. Many county road commissions and cities now have laptop computers; consider using them as backup.
Before you begin collecting road data for the 2015 data collection season, ensure you are using Roadsoft and Laptop Data Collector Version 7.8 (released by April 2015).

Visit [www.roadsoft.org/Downloads](http://www.roadsoft.org/Downloads) for Roadsoft updates.

If you have any questions or concerns, please call Roadsoft support at (906) 487-2102.
Step 1: Identify your TAMC network for data collection

Make sure you are using the local agency’s copy of Roadsoft at the road commission, city, or village for which you will be collecting data. The decision of how to develop a TAMC network is being left up to agencies and Regional Coordinators. Remember that networks must include at least 50% of Federal-aid eligible road networks. These would include all roads that were not collected in the previous year.

Follow the procedure outlined below to create your 2015 TAMC network ¹.

1. Under Map Layers, make sure the Road layer is selected. Right-click the map and select Filter Builder.

2. Add a criterion of Federal Aid as the Field, Equals (=) as the Operator, and True as the Value.

3. Add a criterion of TAMC Collection Year as the Field, Not Equals (<>) as the Operator, and 2014 as the Value.

4. Save this as a network by clicking Save. Give the network a name such as, “2015 TAMC Network” and click Save.

5. Apply your new 2015 TAMC network as a selection by clicking Replace Selection.

6. Examine your 2015 TAMC network on the map by visually verifying the selected segments are appropriate for rating this year.

If you have any questions or issues creating your 2015 TAMC network, please call Roadsoft support at (906) 487-2102.

¹ If you are collecting data for a non-Federal-aid project that TAMC has approved for reimbursement, use the approved network for Step 1. The rest of the steps for data collection (2-10) will follow the same procedure.
Step 2: Export TAMC network for use with the LDC

1. Open *TAMC* menu from the Roadsoft menu bar. Select *1 - (County/City Does This)* *Export Data for LDC.*

2. Click *Export Network,* and then click *Select.* Select your TAMC network from the drop down list. The network you want is the one you saved at the end of your appropriate scenario in *Step 1.*

3. Define an *Export Path;* this is the location on your hard drive where you want to save the export file.

4. Save the export file to the location you specified by clicking the *Export* button.

5. Click *OK* to close the window confirming a successful export.

6. Roadsoft creates two files in the location you specified:
   - RStoLDC_[jurisdiction]_[date]_[time].ldcz
   - RStoLDC_[jurisdiction]_[date]_[time].zip

*For the purposes of 50% network reporting, you will be sending the .zip file to TAMC*

7. Copy the .ldcz file to a CD, flash drive, or other portable storage device so you can transfer it onto the laptop that has the LDC installed on it.
Step 3: Send a copy of TAMC network to the CSS

Your agency should submit a copy of the exported TAMC network to the CSS before beginning data collection.

2. Click the Investment Reporting tab at the top of the page and select Data.
3. Log in using your user ID and password.
4. Select the Send sub-tab.
5. Choose the Other File button
6. Select your jurisdiction from the dropdown menu.
7. Click the Browse button to attach the .zip file you created in Step 2.
8. Click the Upload button to submit the data to TAMC.
9. Finally, you must Update Status to notify TAMC you are complete.
Step 4: Import the network into the Laptop Data Collector (LDC)

1. Insert the portable storage device that contains the export file from the local agency.
2. Start the LDC. You will be prompted to select a database (DB) and Crew name (the name of the person(s) rating).
3. Click the button to locate the export file on the portable storage device.
4. Click OK to import the network into the LDC.

NOTE: If you want to change your database while inside the LDC, select the File menu, then click Change DB (Import Data from Roadsoft).
**Step 5: Connect the GPS to your laptop and begin collecting data**

**Connect the GPS**

1. Start the LDC.
2. With your GPS device turned off, connect it to your laptop using the Serial or USB connection.
   
   **NOTE:** If your GPS is on before connecting it, your mouse pointer may jump around erratically. If this happens, turn off your GPS, leave it connected, and restart windows and the LDC.
3. Turn on your GPS and wait for it to acquire a position (this could take a couple of minutes).
4. From the LDC main menu open the **GPS** menu and select **Start/Stop GPS Connection** to establish communication between the GPS and the LDC. Wait a few minutes for the software to snap to the GPS position on the GIS map. If your GPS fails to connect, wait several minutes and try to connect again, or contact Roadsoft support.
   
   **NOTE:** If you’re not on or near a road segment that is part of the network that you imported into the LDC, the LDC will not snap to a segment on the map. Drive your vehicle toward a road that is part of the network so that the vehicle marker can snap to it. If this does not happen, restart the LDC or call Roadsoft support.

**Collect data**

Use the following shortcut keys to enter data into the LDC:

- **Ctrl + S**  Surface Type
- **Ctrl + 0–9**  PASER
- **Shift + Ctrl + 0–9**  Number of Lanes
- **Ctrl + Enter**  Submit (save) Data
- **Ctrl + +/-**  Zoom In/Out
- **Ctrl + Arrow Keys**  Pan the GIS Map
- **Ctrl + Space Bar**  Hold/Release Segment

For a complete list of shortcut keys, open the **Help** menu and select **Shortcut Keys**.

**IMPORTANT:** While collecting data, back up every hour or as often as conveniently possible. From the main LDC menu select the **File** menu, then **Backup Database** to back up your data. If data collection spans multiple days, export the data every day and save a copy of the data file (LDCtoRS_[jurisdiction]_[date]_[time].ldc2rs) to a CD or flash drive.

**TIP:** The **History** tab provides a history of PASER for the current segment. Viewing past PASER before rating a segment can influence the rating. To avoid possibly influencing the current rating based on past ratings, this grid will not be visible until you submit a rating for the segment.
5. To complete the data collection process, verify that there are no unrated roads in your TAMC network: To do so: click the File menu.

6. Select Current DB Statistics and verify that the Total Miles Not Yet Rated field displays 0. If the field is zero, skip Step 5.

7. In the File menu, select Check for Unrated Segments to open the Unrated Segments form. Highlight a row in the grid to select the segment on the map. Enter a rating for the segment, then move to the next row in the grid. Continue entering ratings for each segment until reaching the bottom of the grid. Click Refresh to update the form. When there are no more records in the grid, all segments have been rated.

Proceed to Step 6 once all the roads in your TAMC network are rated.
Scenario A: Agencies that must define their Federal-Aid Unpaved Road Network inventory

Teams must drive the non-paved roads segments on the Federal-aid system and verify the pavement type on the road segment, if they have not done this already. Road segments that have a surface type currently set as “Undefined” must be validated by changing the surface subtype to the appropriate subtype. Then, click the Validate Surface Type button to save the data.

If the inventory data (start and end point of the segment) for the unpaved road segments are already current, teams can click each individual unpaved segment (which will be colored orange) in the LDC and click Validate Surface Type without having to drive the entire segment.

Scenario B: Agencies that have already defined their Federal-Aid Unpaved Road Network inventory

If the inventory data (start and end point of the segment) for unpaved road segments are already current and accurate, a tool to mass-validate these segments can be found in the File menu of the LDC. Click the File menu and choose Check for Unvalidated Non-Paved Segment from the drop-down menu.
Place a check next to each segment that will be validated using this tool. After checking all or some segments, click the **Validate Checked Segments** button to submit an inventory validation for the checked segments. All orange segments that are checked with this tool should now be colored green on the map to indicate that they have been validated.

**NOTE:** Only agencies that have accurate unpaved-road inventories for the Federal-aid system should use this tool.
Step 6: Export collected data from the LDC

**NOTE:** Data can only be passed to TAMC using TAMC LDC export.

1. From the LDC main menu, select the **File** menu, then **Export DB/Data to Roadsoft**.

2. In the **Export Path** field, enter a location on your hard drive to save the export file. Click the button to browse your hard drive.

3. Click the **OK** button once the Export Complete notice displays.

4. Copy the “LDCtoRS_[jurisdiction]_[date]_[time].ldc2rs” file to a portable storage device.

**IMPORTANT:** The “LDCtoRS_[jurisdiction]_[date]_[time].ldc2rs” file contains a great deal of information that could be useful for emergency data recovery purposes. The Roadsoft team **strongly recommends** that you save a copy of the file in a permanent archive **every day** to facilitate data recovery.

This file can also be used to update small cities and villages with limited Federal-aid miles.
Step 7: Import the collected data to Roadsoft

**IMPORTANT:** Before you import new data into Roadsoft, back up your existing Roadsoft database. To do so, select the **Tools** menu, then **Backup Roadsoft Database** from the Roadsoft main menu. Roadsoft has to shut down to run the Database Manager. You can restart Roadsoft after backing up the data.

1. In the main Roadsoft window, open **TAMC** menu and select **2 - (County/City Does This) Import TAMC PASER Data from LDC.**

2. In the **Import Data from LDC** window, click the **Browse for LDC Export** button, and then locate the “LDCtoRS_[jurisdiction]_[date]_[time].ldc2rs” file.

3. If you haven’t already backed up your Roadsoft data, click the **Yes** button to open the Roadsoft Database Manager and create a backup, then proceed with importing your collected data. If you already backed up your data, click the **No** button to continue with the import.

When the import process is completed, Roadsoft will automatically restart.
Step 8: Export Roadsoft asset management data for the regional version of Roadsoft

1. In the main Roadsoft window, open TAMC menu and select 3 - (County/City Does This) Export TAMC PASER Data to Region.

2. In the Export Path field, enter a location on your hard drive to save the export file. Click the button to browse your hard drive.

3. Click OK when your export has been completed successfully.

4. Roadsoft creates a file named “TAMC_[jurisdiction]_[date]_[time].tamz” in the location you specified. Copy this file to a portable storage device for import into the Region’s version of Roadsoft.
Step 9: Import Roadsoft asset management data from the local agency into the regional version of Roadsoft

**NOTE:** This step is not performed in the field; it should be performed at the regional office to import inspection data from individual agencies.

**IMPORTANT:** Before you import new data into Roadsoft, back up your existing Roadsoft database. To do so, open the Tools menu and select *Backup Roadsoft Database* from the Roadsoft main menu. Roadsoft has to shut down to run the database manager. You can restart Roadsoft after backing up the data.

1. In the main Roadsoft window, open *TAMC* menu and select *4 - (Region Does This) Import TAMC PASER from County/City*.
2. In the *Import Data from Local Jurisdiction* window, click the *Browse For LDC Export* button, and then locate the “TAMC_[jurisdiction]_[date]_[time].tamz” file.

3. If you haven’t already backed up your Roadsoft data, click the *Yes* button to open the Roadsoft Database Manager and create a backup, then proceed with importing your collected data. If you already backed up your data, click the *No* button to continue with the import.

   When the import process is completed, Roadsoft will automatically restart.

**NOTE:** The *Import Roadsoft Data* screen lists the last four folders that you imported from. If this is the first time you’re importing data, the screen will appear blank.
Step 10: Export shape file and submit to TAMC

NOTE: Once your regional data are complete, export the regional shape file to the CSS.

1. To verify your regional data before proceeding, follow the steps in Section 5.
2. In the main Roadsoft window, open TAMC menu and select 5 - (Region Does This) Export TAMC Shape File to Council (Individual County Files).

NOTE: Do not use the standard Roadsoft Shapefile Export, as it is different than TAMC export.

3. Select the County you wish to export using the drop-down menu in the County field.
4. In the Export Path field, choose the path where you want to save the export file.
5. Click the Export button to export the data to the specified export path. The filename that is created will contain the county and year of data. (e.g. Alcona2015.zip)
6. Follow the guidelines in Step 3 to upload the exported file to TAMC through the CSS Investment Reporting Tool (IRT). However, for this step you must choose the PASER button rather than Other File button in Step 3:5.
Section 3: Michigan-specific Information

Sealcoat Road Rating Guide

The PASER system rates a sealcoat road (sealcoat over a gravel base) on a scale of 1 to 5. However, TAMC has decided to adopt a modified version of this rating system based on a 1 to 10 scale. This standardizes ratings so that all surface types in your TAMC network are rated on the same scale. The Michigan sealcoat scale is based on the relative percent of distress observed in the pavement.

Using the “Percentage” approach

The Michigan sealcoat scale is based on the percentage of distress over a cross section of the total length of the segment under consideration.

The distresses are:

- Edge distress
- Lane distress (including rutting)
- Raveling

These percentages are **not** cumulative.

Consider a cross section of the roadway segment; it can be 50 ft. long or 1 mile long. If neither of the surface distress percentages outlined in the sealcoat rating chart exceed the upper limit of a rating description, then that rating is your selection.

As another example: a sealcoat with a rating of 5 allows up to 20% raveling, 20% edge distress or 20% lane distress. If your assessment yields 10% raveling, 5% edge distress and 20% lane distress, the rating is 5 because neither of the distresses exceeds 20%. It is not a rating of 6 because lane distress exceeds the 10% criteria, and it is not a rating of 4 regardless that the cumulative total distress percentage exceeds the 20% individual limit for 5.

Consult the table on the following page for specific rating criteria.
<table>
<thead>
<tr>
<th>Rating</th>
<th>Description</th>
<th>Condition / defects</th>
<th>Remedy / action</th>
<th>Typical age in years *</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Excellent</td>
<td>New construction</td>
<td>None</td>
<td>&lt; 1 year</td>
</tr>
<tr>
<td>9</td>
<td>Excellent</td>
<td>Like new</td>
<td>None</td>
<td>1 to 3</td>
</tr>
<tr>
<td>8</td>
<td>Very good</td>
<td>First signs of distress</td>
<td>Routine maintenance</td>
<td>3 to 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Limited edge distress</td>
<td>Minor edge seal</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Good</td>
<td>Minor distress</td>
<td>Minor asphalt or spray-injection patching</td>
<td>4 to 6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edge distress with limited lane distress &lt;5%</td>
<td>Possible single application sealcoat</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Raveling &lt; 5%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Good</td>
<td>Moderate distress</td>
<td>Moderate asphalt or spray-injection patching</td>
<td>5 to 7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edge distress up to 10%</td>
<td>Single application sealcoat</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress up to 10%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Raveling up to 10%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Fair</td>
<td>Distressed</td>
<td>Moderate asphalt or spray-injection patching</td>
<td>6 to 8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edge distress up to 20%</td>
<td>Single application sealcoat</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress up to 20%</td>
<td>With up to 50% double application sealcoat</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Raveling up to 20%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Fair</td>
<td>Edge distress up to 30%</td>
<td>Asphalt or spray-injection patching</td>
<td>7 to 9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress up to 30%</td>
<td>and double application sealcoat</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rutting of ½” to 1”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Poor</td>
<td>Edge distress up to 50%</td>
<td>Wedge and /or asphalt or spray-injection patching and double or triple application sealcoat</td>
<td>8 to 10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress up to 50%</td>
<td>May be necessary to crush and reshape prior to new sealcoat surface</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rutting of 1” to 2”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Very poor</td>
<td>Edge distress &gt; 50%</td>
<td>Reconstruct by crush and shape prior to new sealcoat surface, possible return to gravel</td>
<td>&gt; 9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress &gt; 50%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rutting greater than 2”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Failed</td>
<td>Extensive distress</td>
<td>Reconstruct by crush and shape prior to new sealcoat surface, or return to gravel</td>
<td>&gt;10</td>
</tr>
<tr>
<td>0</td>
<td>Not rated</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Rutting and Asphalt PASER Manual

In the Asphalt PASER Manual, the description for the extent of rutting is stated as Rutting less than ½” for a PASER of 4. For Michigan’s data collection this should be revised to Rutting ½”-1” for a PASER of 4. Please note this in your PASER Manual and refer to the PASER Cheat Sheet for additional information.

In the Asphalt PASER (Revised 2013) Manual the description for the extent of rutting is stated as Rutting 1/2” deep or less for a PASER of 4 and Rutting greater than ½” but less than 2” for a PASER of 3. For Michigan’s data collection this should be revised to Rutting ½”-1” for a PASER of 4 and Rutting 1”-2” for a PASER of 3. Please note this in your Asphalt PASER Manual and refer to the PASER Cheat Sheet for additional information.

Block Cracking and Asphalt PASER Manual

In both versions of the Asphalt PASER Manual the description for the extent of Block Cracking is “Block Cracking up to 50% of the surface” for a PASER of 5, “Block cracking (over 50% of the surface)” for a PASER of 4 and “Severe block cracking” for a PASER of 3. As the 50% of the surface descriptor is undefined for Michigan’s data collection this should be revised to “Initial block cracking (6’-10’ Blocks)” for a PASER of 6, “Moderate block cracking (1’-5’ blocks)” for a PASER of 5, “Severe block cracking (less than 1’ blocks)” for a PASER of 4 and “Severe block cracking (alligator)” for a PASER of 3. Please note this in your Asphalt PASER Manual and refer to the PASER Cheat Sheet for additional information.

PASER 9 and Concrete PASER Manual

In the Concrete PASER Manual, on page 17, the bottom photograph includes the description “RATING 9 Recent joint rehabilitation. Like New condition.” This example should be crossed out or noted as this situation is extremely unlikely to occur due to the fact that by the time a concrete pavement requires joint rehabilitation the original concrete slabs are probably not going to be in a “Like New condition” (without any distresses).
**Section 4: Splitting Segments**

The Roadsoft map initially splits all street and road segments on an intersection-to-intersection basis (node to node) or by using Act 51 boundaries (township/city/county). Users can add road segment splits to denote changes in surface types or conditions.

Rating teams should respect segment splits previously created within Roadsoft by local agencies. The following sub-sections on splitting segments will help you decide if introducing new splits is warranted, and how to introduce those new splits if necessary while collecting TAMC data.

**Guiding principles for splitting segments**

- If the area in question has received rehabilitation or reconstruction separate from the framework segment from which it came, then the segment in question should be split from the framework segment into its own designated rating segment.
- Avoid splitting segments into lengths of less than ¼ mile.

**Good reasons for splitting segments**

**Change in Surface Type**

If the road surface changes from asphalt to gravel, asphalt to chip seal, chip seal to gravel, etc., then splitting a segment to reflect that change in surface type can ensure that the inventory collected is representative of the actual road conditions.

**Number of Lanes**

Commercial or development activity may require the addition of through lanes or continuous left turn lanes within a given framework segment. Splitting a segment to reflect this change will ensure that Roadsoft’s lane mileage inventory reflects the true mileage.

**Intersection as a Unique Facility**

Many intersections within a county/city system are extensions of segments, meaning their design, surface type, service life, and number of lanes is no different than the segment they stem from. However, some intersections have significant changes in surface type and/or geometry. In these cases, it may be best to designate the intersection as a unique facility by making it a distinct segment.

**Environmental Factors**

Environmental factors can have a significant impact on a segment of road. For example, regular flooding or exceptional frost heave can cause severe damage to the roadway. Although this type of deterioration is rare, if they are longer than a ¼ of a mile they should be designated as their own segment so as to isolate the area needing rehabilitation or reconstruction.
Bad reasons for splitting segments

The following cases do not affect the network as a whole, and therefore do not warrant segment splitting:

- Change in PASER over a short stretch (Example: 50 feet)
- Short right or left turn bay
- School zone
- Traffic count segments
Section 5: PASER Data Quality Control Guide

It is important to ensure that your PASER data are accurate and comprehensive. It is easiest to check for errors in data at the local and regional levels before submitting data to TAMC. Data quality control can be performed by entering a series of queries into the Filter Builder in Roadsoft. The following steps will guide you through this process and ensure that your agency has a complete set of PASER data.

**NOTE:** Changes to data will only be sent to TAMC if they were collected in the LDC or hand-entered in the region version of Roadsoft. Rating and changes in ratings should be initially entered in the LDC (not in Roadsoft) or data will not be reported. Data entered into Roadsoft (rather than being collected in the field) will result in missing data when the final collection file is sent to TAMC.

**Step 1: Determine the total length of your network**

a. Open the Filter Builder either by right-clicking on the map and selecting Filter Builder, or by clicking on the map toolbar’s Filter button and selecting Filter Builder.

b. In the Filter Builder window, click the Open button to open the Load Saved Filter window.

c. Select your saved TAMC network for the current collection year and click the OK button.

d. Look at the bottom left of the Filter Builder window. Record the number of Total Miles. You will use this number, along with additional criteria, to verify that your regional PASER data are correct.

**Step 2: Determine the total length of paved segments in your network**

a. Open the Filter Builder either by right-clicking on the map and selecting Filter Builder, or by clicking on the map toolbar’s Filter button and selecting Filter Builder.

b. In the Filter Builder window, click the Open button to open the Load Saved Filter window.

c. Select your saved TAMC network for the current collection year and click the OK button.

d. Add Criteria of Surface Type = Asphalt, Concrete, Seal Coat, Brick and click the Add button. Look at the bottom left of the Filter Builder window. Record the number of Paved Miles. You will use this number, along with additional criteria, to verify that your regional PASER data are correct.
**Step 3: Verify that your agency’s TAMC data are accurate**

Using the filter criteria provided in the Table of Quality Control Queries (below), you will be able to detect missing or incorrect data by comparing the Miles in a particular query against your original Miles (generated in Section 5, step 1 above).

In the Table of Quality Control Queries:
- **Check** lists the potential error that the criteria checks for
- **Criteria** lists the criteria that need to be entered into the network and Filter Builder
- **Expected Output** lists the segments/mileage that should display at the bottom left of the Filter Builder after adding the criteria
- **Troubleshooting** lists the most likely reason for not getting the expected outcome and steps to take to fix/obtain any inaccurate/missing data.

**Table of quality control queries**

Ensure you have recorded the Miles within your TAMC network (Section 5, step 1 above) before you use the following table. Used in combination with these queries, those figures will help you verify the data you collected for TAMC are accurate and complete.

<table>
<thead>
<tr>
<th>Check</th>
<th>Criteria</th>
<th>Expected Output</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check that all mileage in TAMC network have been rated</td>
<td>TAMC Collection Year = <em>current year</em></td>
<td>Number of miles recorded in Step 1</td>
<td>There are segments that did not receive a rating. Missing rating data must be collected and entered in the LDC.</td>
</tr>
</tbody>
</table>
| Check to see if all submitted segments have a valid surface type | TAMC Collection Year = *current year*  
Surface Type <> Undefined | Number of miles recorded in Step 1 | There are undefined roads in the network. Validate these segment types using the LDC. |
| Check to see if all submitted paved segments have a valid surface rating | TAMC Collection Year = *current year*  
Latest Surface Rating >= 1 - Failed | Number of miles recorded in Step 2 (Paved Miles) | There are segments that have an invalid rating. These segments should be reviewed and rated in the LDC. |
| Check to see if all submitted segments have a valid number of lanes | TAMC Collection Year = *current year*  
Number of Lanes <= The highest number of lanes within your TAMC network  
*An unusually high number of lanes in the drop down list could signify an error in entry* | Number of miles recorded in Step 1 | There are segments that have an invalid number of lanes. Segments with invalid lanes should be reviewed and corrected in the LDC. |
Appendix A – Michigan’s Regional Planning Organizations

Map Legend
1. Southeast Michigan Council of Governments
2. Region 2 Planning Commission
3. Southcentral Michigan Planning Council
4. Southwestern Michigan Commission
5. GLS Region V Planning Commission
6. Tri-County Regional Planning Commission
7. East Central Michigan Planning & Development Region
8. West Michigan Regional Planning Commission
10. Northwest Michigan Council of Governments
11. Eastern Upper Peninsula Regional Planning and Development Commission
12. Central Upper Peninsula Regional Planning and Development Commission
13. Western Upper Peninsula Planning and Development Regional Commission
14. West Michigan Shoreline Regional Development Commission

*RPOs/MPOs responsible for PASER collection in Region 3 in 2013:
Kalamazoo Area Transportation Study (KATS) for Barry, Kalamazoo, St. Joseph, & Branch Counties
Battle Creek Area Transportation Study (BCATS) for Calhoun County
Appendix B – Michigan’s Metropolitan Planning Organizations

State of Michigan Metropolitan Planning Organizations (MPOs) as of May, 2013

Legend
- County
- 2010 Urbanized Areas
- Battle Creek Area Transportation Study
- Bay County Transportation Planning Division
- Calhoun County Metro Alliance
- Grand Traverse Area Metropolitan Planning Commission
- Kalamazoo Area Transportation Study
- Macatawa Area Coordinating Council
- Midland Area Transportation Study
- Region 2 Planning Commission
- Saginaw County Metro Planning Commission
- Southeast Michigan Council of Governments
- Southwest Michigan Planning Commission
- Tri-County Regional Planning Commission
- West Michigan Metro Transportation Planning Program

0 25 50 100 Miles
Appendix C – New Midland Area Transportation Study (MATS) Boundary
Appendix D – PASER Certification/Training Requirement Policy

This document is based on the policy adopted by The Transportation Asset Management Council on February 6, 2013. To view the policy go to [http://tamc.mcgi.state.mi.us/MITRP/Council/Policies.aspx](http://tamc.mcgi.state.mi.us/MITRP/Council/Policies.aspx)

Introduction:
The Transportation Asset Management Council (TAMC) was established to expand the practice of asset management statewide to enhance the productivity of investing in Michigan’s roads and bridges. Part of TAMC’s mission is to collect physical inventory and condition data on all roads and bridges in Michigan. This document describes the policy and procedures for collecting the physical inventory and condition data on the federal-aid eligible roads & streets of the State.

Requirements:
According to Act 51 (P.A. 499 2002, P.A. 199 2007); each Local Road Agency and the Department of Transportation shall annually report to TAMC the mileage and condition of the road and bridge system under their jurisdiction.

Rating Teams:
- Shall be comprised of one (1) member from the Michigan Department of Transportation (MDOT), one (1) member from the Regional / Metropolitan Planning Organization (RPO/MPO) and one (1) member from the Act-51 jurisdiction being rated (County, City/Village).

Training:
- Anyone who participates in the annual PASER condition data collection of the federal-aid system and influences the rating activity MUST attend on site PASER training in the same year the data collection occurs. This does not discourage observers from riding in the data collection vehicles for information purposes.
- New raters (never attended PASER training before) and seasoned raters (who did not attend PASER training the year prior) MUST attend one (1) supplemental PASER webinar training session in addition to attending one (1) on site session.
- Individuals that are PASER Certified Raters are exempted from on-site training as defined in PASER Certification Eligibility Requirements section of this policy.
- RPO and MPO coordinators are required to attend onsite training events every year regardless of their experience or certification status. RPO and MPO representatives are critical to the success of TAMC PASER data collection, so it is important for them to continue to promote and support the program by attending on site events.
PASER Certification Eligibility Requirements

To be considered a candidate to take the PASER certification exam the individual must meet the following criteria:

1) All candidates: Six (6) or more years (not including the current calendar year) of attendance of TAMC PASER on-site training as verified through the Center for Technology & Training (CTT) records.

2) Candidates that are civil engineers: five (5) or more years (not including the current calendar year) of attendance of TAMC PASER on-site training as verified through CTT records.

3) Rated a portion of their road network during TAMIc collection for the same number of years trained (not including the current calendar year). This will be verified by a signed letter from the individual stating their rating experience.

4) Attend the current calendar year TAMC PASER on-site training portion of the workshop as well as the examination administration portion of the workshop.

Certification Exam

1) The written certification exam will be administered at the on-site sessions of TAMC PASER training to eligible candidates.

2) Candidates must pass the written certification exam during the on-site training sessions. The passing score is 70% correct or will be adjusted using the normal distribution (bell curve) of the scores depending on the difficulty of the exam questions at the discretion of CTT staff.

3) Candidates who do not pass the certification exam will be able to attend another on-site PASER session during the same year and retake the exam as space and administration allows. Individuals may repeat examination sessions as many times in one year as space and administration allows.

4) TAMC will hold exam results and exam questions as documents that are not open to the public without a freedom of information act request to prohibit development of files of exam questions that can be used to memorize facts rather than learning concepts.

Certification Benefits and Responsibilities

1) Certified raters are required to attend on-site TAMC PASER training every other year; i.e. a two (2) year cycle to recertify by taking the certification exam. For example:
   a. Certification Year: Candidate is required to attend TAMC PASER on-site training portion of the workshop as well as the exam administration portion. If the candidate passes the certification exam he/she is certified for that and the next rating season.
   b. One year after Certification Year: The certified individual is not required to attend TAMC PASER on-site training portion of the workshop or the exam administration portion during the calendar year immediately proceeding the year of certification. Certified individuals must attend an organizational webinar.
   c. Two years after Certification Year: Recertification - the certified individual is required to attend TAMC PASER on-site training portion of the workshop as well as the exam administration portion to take the exam for recertification.

As data is collected and Quality Assurance/Quality Control verifies that quality data is being produced, TAMC may consider decreasing the required training certification frequency to once every three (3) years for certified individuals.

2) Certified individuals are required to attend an organizational webinar for updates to business rules and changes to the data collection process. This webinar is required to keep certified raters informed of new guidance in the program and provides raters with an opportunity to interact with TAMC members.
Data Collection:

- TAMC will annually budget for data collection on 50% of the federal-aid network.
- Data collection must be consistent with the PASER collection business rules.
- The use of the Roadsoft Laptop Data Collector (LDC) is required.
- The first day for field data collection shall be April 1st of every year.
- The last day for field data collection shall be the last Friday in November.

Data Submission:

- The RPO/MPO Coordinator is responsible for submitting the completed PASER Data export to the Michigan Center for Shared Solutions (CSS).
- The deadline for the RPO/MPO to upload data to CSS is the first Friday in December.

Data Standards:

The export file from Roadsoft will be in a Shapefile format. It is the user's responsibility to ensure that the correct file type is submitted. Exports containing text files are not accepted.

Instructions on how to prepare the federal-aid road network for the LDC and how to submit the collected data can be downloaded at the following web site:

*See the current year’s PASER Training Manual under the PASER Training page at http://www.michiganltap.org/PASER_Manual*

Quality Control:

The Regional/Metropolitan Planning Coordinator MUST review the collected data before sending it to the Center for Shared Solutions (CSS) looking for missing entries (zeros), valid surface type, missing surface type, valid number of lanes, missing lane information and large jumps in PASER (up/down) in areas where treatments were not done.

Reimbursement:

Each rating team must complete a Time Expense Log in order to be reimbursed by TAMC. These are provided and submitted by the Regional / Metropolitan Planning Organization Coordinator to TAMC Asset Management Coordinator.

- The team member representing the Act-51 jurisdiction being rated (County, City/Village) will be reimbursed for relevant expenses related to the data collection effort (time, travel, meals) via annual RPO/MPO project authorization with TAMC.
- The team member representing MDOT will be reimbursed by TAMC via annual approved budget for PASER review.
- The team member representing the RPO/MPO will be reimbursed via annual project authorization with TAMC.

If you have any questions relating to reimbursement and/or this policy as a whole, please contact:

Frank Kelley – TAMC Asset Management Coordinator
Michigan Department of Transportation
P.O. Box 30050
425 W. Ottawa St.
Lansing, MI 48909
517.373.2111
kelleyf@michigan.gov
Appendix E – Data Collection Timesheet

This form is an example. Please obtain appropriate Time Expense Logs from your RPO/MPO.

TRANSPORTATION ASSET MANAGEMENT COUNCIL
DATA COLLECTION - ROAD INVENTORY LOG

<table>
<thead>
<tr>
<th>CREW INFO: Please insert the names of the crew.</th>
<th>Date:</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-DOT Region -</td>
<td></td>
</tr>
<tr>
<td>Planning Region -</td>
<td></td>
</tr>
<tr>
<td>County -</td>
<td></td>
</tr>
<tr>
<td>City -</td>
<td></td>
</tr>
<tr>
<td>Hours/Minutes Worked:</td>
<td></td>
</tr>
</tbody>
</table>

Please check the following work type:

<table>
<thead>
<tr>
<th>OFFICE WORK:</th>
<th>FIELD WORK:</th>
</tr>
</thead>
</table>

GEOGRAPHIC AREA: Please insert region, county, township, city, etc.

MILEAGE LOG:

<table>
<thead>
<tr>
<th>VEHICLE:</th>
<th>General Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEGIN MILE:</td>
<td></td>
</tr>
<tr>
<td>END MILE:</td>
<td></td>
</tr>
<tr>
<td>TOTAL:</td>
<td></td>
</tr>
</tbody>
</table>

TOTAL MILES OF FED-AID ELIGIBLE ROADS INVENTORYED:

Please fill out this form each day you perform asset management tasks. E-mail to chesbrog@michigan.gov. If you have any questions, please contact Gil Chesbro at 517-335-2963 (office) or 517-242-3535 (cell)
Appendix F – Framework Error Form

Asset Management Change Request for Michigan Geographic Framework

Map Reference Number: ____________  Date Observed: / / 
Contact Information  Agency: ____________________________
Contact Name: ____________________________
Phone Number: (____)  E-Mail: ____________________________

Is the Observer the same person as the Contact person? If no:
Observers Name: ____________________________  Agency: ____________________________
Phone Number: (____)  E-Mail: ____________________________

Location Information
County: ____________________________ Township/City/Village: ____________________________
Street Name: ____________________________ PR 1: ____________________________
Cross Street 1: ____________________________ PR 2: ____________________________
Cross Street 2: ____________________________

Who has jurisdiction of this road?

What kind of Change? (Please Check One)
☐ Intersection Reconfiguration  ☐ Road Addition  ☐ Road Removal
☐ Road Interruption: IF YES, what is the cause?  ☐ Other, please explain (use back for more space):

What year did this change occur?

This form can be found at: http://www.michigan.gov/documents/cgi/CGI_AssetManagement_178936_7.pdf
The Center for Technology & Training is located on the campus of Michigan Technological University. Programs managed by the CTT include Michigan LTAP, Roadsoft, MERL, and the Bridge Load Rating Programs. The CTT’s mission is to develop technology and software, coordinate training, and conduct research to support the agencies that manage public infrastructure. For more information, visit www.ctt.mtu.edu